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Introduction 

Welcome to IntraMaps, a powerful web based GIS application that allows you to deploy web 

mapping capabilities across your enterprise. IntraMaps allows organisations to distribute their 

spatial data to the widest possible spectrum of users in the organisation and implements 

functionality to allow for the viewing, querying and analysis of spatial and textual data and 

the representation of the relationships between spatial and textual data. 
 

What is IntraMaps? 

 

What is IntraMaps? IntraMaps is a powerful web based GIS data view, query and analysis 

solution that allows mapping capabilities to be deployed across the internet. IntraMaps spatial 

search engine allows users to query and search spatial and textual data from within a 

standard Web browser. IntraMaps allows the user to view and query information from a 

corporate GIS and related databases. IntraMaps is maintained and updated by a GIS 

administrator to ensure all users receive consistent, current, and accurate information. Users 

are not able to modify spatial or textual data in IntraMaps. Simply log on to IntraMaps and 

explore the maps that are available in the various modules.  

 

IntraMaps is designed to link text information from the corporate database to spatial or 

mapping data stored in the GIS data warehouse. For example, if you have a property module 

you can click on a property parcel and expect to see the property highlighted to confirm it has 

been selected and secondly, a text display of all text information such as, address, owner, 

property dimensions, zoning, etc.. displayed alongside the map.  

 

Searching can be spatial (Point Select, Marquee Select etc...) via the Map Window, or textual 

via the Search Forms located below the map window.  The appropriate search technique will 

be decided by the amount and type of information the user has about the location being 

queried.  

 

In general, most layers in IntraMaps cannot be edited, with the exception being those layers 

configured using the Data Entry tool, however this is configured and controlled by the GIS 

Administrator. As a result for the general user it is not possible to accidentally add, delete or 

modify data that you see in IntraMaps.  It has been designed primarily as a viewing tool with 

the optional ability to add data by designated users as managed & maintained by the GIS 

Administrator.  
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Application 

IntraMaps is a dynamic application and as such provides its own set of tools. The IntraMaps 

application is displayed within a custom web browser which has the menu items and standard 

toolbars removed. 

The IntraMaps screen consists of six main areas:  

 

The Main Toolbar contains all the tools to make selections, control the view and navigate 

around the map. It also has tools that allow the user to carry out Mail Merge selections, add 

and save Annotations as well as Data Entry capabilities providing it's been set up by the GIS 
administrator.  

The Map Window displays spatial data which is stored on a central server. The map display 

consists of one or more layers (groups of similar spatial data are often referred to as layers) 

and will often show both raster data (Photography) and vector data (Points, Lines & 

Polygons). To navigate within the map window use the navigation tools located above the 
map.  

The Information Panel is located to the right of the map window. The Information Panel is 

dynamic and only appears when a Selection is made. The data displayed within the 

Information Panel is very flexible and may be from a variety of different databases, which are 
linked to the map layers in the map window.  

The Search Panel appears below the map window and contains any search forms that have 

been configured by your system administrator. These search forms allow you to search for 

and select objects in the map window using differing search criteria.  
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The Sidebar appears to the left of the Map Window and consists of three panels: Modules, 

Layers and Views. The Modules Tab has search forms and map layers specifically configured 

to a particular 'theme'. The Layers tab displays a list of layers available in the Map window for 

the user to manipulate. The View Tab allows users to zoom to particular coordinates and 
scale, and save favourite views of the map to access quickly in the future.  

The Overview Map appears to the bottom left of the Map Window and allows for a dynamic 
overall view tool.  

Main Toolbar 

IntraMaps has been designed to minimise the number of tools to provide a simple and 

intuitive graphical user interface for a broad range of users. The toolbars have been divided 

into a series of tabs that allow users to perform different functions on the map.  

 

 
The tools are activated by clicking once on the tool icon. Clicking on a tool icon makes that 

tool the current active tool for use within the Map Window. All tools contain 'tool tip' 

information by moving the cursor over the top of the tool. Some of the tools described below 

allow Click and Drag by the mouse to perform multiple selections or marquee zooming. To 

Click and Drag the mouse, click the left mouse button and hold it while moving the mouse. 

Release the left mouse button when the marquee area covers the required area.  

 

The Main Toolbar is broken into the following sections  

 

1.) View  

 

2.) Tools  

 

3.) Export  

 

4.) Annotation  

 

5.) Data Entry  
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View 

The View control tool bar allows the user to control the current view shown in the map. These 

tools also allow the user to move around the map and obtain greater visual detail on objects 

by allowing the user to control the zoom level.  

 

Original View: 

This tool is used to zoom the map to its default view. In most instances will be the broadest 
view of the data available allowing the user to zoom out quickly.  

Pan: 

This tool allows the user to move the map by dragging it to a new location. Click the left 

mouse button on the tool to activate it. Click and hold the left mouse button and drag the 

map to the desired location. The map will then refresh showing the detail within the new 
location.  

Zoom In: 

This tool allows the user to enable a single click to zoom in by a factor of two, or draw a 

marquee so that the zoom area can be defined. Click the left mouse button on the tool to 

activate it. Then single click on the map to perform a zoom in on a particular location. The 

map will zoom in at twice the previous zoom level. If the user clicks and holds the left mouse 

button, then drags a rectangle (marquee) and releases the mouse button, the map will zoom 
in to the area that the user has defined within the marquee.  

Zoom Out: 

This tool allows the user to use a single click to zoom out by a factor of two. Click the left 

mouse button on the tool to activate the it. Then single click on the map to perform a zoom 

out. The map will zoom out twice the original zoom level.  

Back: 

Click the left mouse button on the tool to go back to the previous view. This tool only 

changes the Map View and will not alter the selections the user has made. To navigate 

between selections use the previous and next buttons in the Information Panel. This button is 

similar in function to the web browser's 'Back' button, however it only affects the Map 
Window view.  

 

Forward: 

This tool is used to take the user to the next map view. This button is greyed out if it is not 

available (usually it only becomes active after using the Back button, see above) and 
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becomes active as long as there is a next view that it can display. Click the left mouse button 

on the tool to go to the Next View. This tool only changes the Map View and will not alter the 

selections the user has made. To navigate between selection use the previous and next 
buttons in the Information Panel.  

View: 

 

The View dialogue shows the user, current zoom, scale and central map coordinates. This is 

dynamic and changes based on the current map view, i.e. As the user zooms in and out the 

zoom and scale values change accordingly. Similarly as a user pans the map in any direction 
the central map coordinates are also updated.  

This tool can also be used as a 'Go to' function i.e. If the user has a desired zoom or scale 

value that they wish the map to display at, then the user can type the value in the relevant 

sections and press the 'Go' button and the map will display at the desired view. Similarly if 

the user has a known XY coordinate location that they would like the map to zoom to then 

this can be entered in the relevant X & Y coordinate locations. Once the desired coordinates 

have been added the user can then press the 'Go' button and the location will highlight on the 

Map window i.e.  

 

Projection: 

 

The Projection dialogue works in conjunction with the 'View' dialogue as mentioned above. 

The view dialogue can change based on a selected projection. For example if the user wishes 

to locate a position on the map at a specified Latitude/Longitude then this is possible by 

selecting a corresponding projection from the drop down menu i.e. GDA94 Lat/Long. Once 

selected the coordinates in the 'View' dialogue will change to reflect the selected projection.  
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Stored Views:  

 

The 'Stored Views' Panel allows the user to save the current map view i.e. the data that is 

displayed in the 'Views' section above. Views can only be saved if the user is authenticated. 

This is set up by the administrator.  

To Save a view, simply zoom into a location, and then click the 'Save' button. The save view 

dialogue box appears i.e. below.  

 

Enter the View Name and any required notes. Click Save and your view name appears in the 

Saved Views dialogue. You now have the ability to go to this view at any time, and in any 

module, by clicking on the Saved Views name. Additionally, specific views can be saved to be 

used at a later date, provided appropriate security settings are used. Check with your system 

administrator if you are unable to save views.  

 

Tools 

Overview 

The selection tools are used to retrieve information about objects that are in the current 

Search Layer. It is important to understand that there may be many layers in the map 

window, but only the ones configured in the selection layer below will have information 

attached to it.  The information is displayed in the Information Panel (to the right of the 

map).  

 

  
 

Each IntraMaps module now has the ability to have multiple selection layers. When a 

selection tool is used in the map window it is applied to the current selection layer that is 

visible in the Selection Layer drop down menu. By doing this a layer containing, for example, 

vegetation boundaries can be used to allow automatic zooming and selection to a specific 

vegetation boundary. Usually, a module title will indicate which layer is the default search 

layer, however this is not always the case so check the Selection Layer box (as described 

above). For example a vegetation module may have a default search layer containing 

vegetation information but also an additional cadastre layer that provides the facility for 

property searches and cadastral information etc...  
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Point Selection: 

 

This Tool is used to select objects on the Search Layer, using a point to define the search 

region. Click the left mouse button on the tool to activate it. Click the left mouse on an object 

to retrieve information on that object. 

 

Panning of the map can be done by holding the left mouse button down and dragging the 

map, while point selection is active. 

Circle Selection: 

 

This Tool is used to select objects on the Search Layer, using a circle to define the search 

region. Click the left mouse button on the tool to activate it. Click and hold the left mouse 

button and then drag the mouse away from that point to define a selection circle (shown in 

blue). The radius of the circle and the coordinates of your mouse pointer will be displayed in 

the status bar at the bottom left of the screen. Release the left mouse button to apply the 

selection.  

Rectangle Selection: 

 

This Tool is used to select objects on the Search Layer, using a rectangle to define the search 

region. Click the left mouse button on the tool to activate it. Click and hold the left mouse 

button and then drag the mouse away from that point to define a rectangle (shown in blue) 

to select within. The height and width of the rectangle and the coordinates of your mouse 

pointer will be displayed in the status bar at the bottom right of the screen. Release the left 

mouse button to apply the selection.  

Polygon Selection: 

 

This Tool is used to select objects on the Search Layer, using a user define region to define 

the search region. Click the left mouse button on the tool to activate it. Click the left mouse 

button and then click at each intermediate point until you have defined all the edges of the 

region to select, then double-click the mouse to close the polygon on the last point. As you go 

the coordinates of your mouse pointer and the length of each line created will be displayed in 

the status bar at the bottom left of the screen.  

Share Boundary Selection: 

This tool allows you to select all objects in the search layer that share a common boundary. 

Click on the tool and then left click on an object in the map. All objects sharing a common 

boundary with the one you specified will be added to the selection. 

Buffer Around: 

This Tool is used to select objects on the Search Layer, using a user defined selection within a 

specified distance of an object you click in the search layer. Click on the tool and enter a 

distance in the text field to the left of the button. Then left click on an object in the map. All 

objects within the specified distance of the object you specified will be selected.  
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 Add to Selection: 

When activated, by clicking on the icon, every selection becomes a cumulative one. As a 

result a series of selection tools and searches can be used to create a cumulative selection. 

This is useful when creating a MailMerge. 

 Remove From Selection: 

This tool is used to remove objects from the current selection, it behaves like the Rectangle 

Tool by removing objects from the selection that are within the drawn rectangle. 

Selection Layers: 

 

This dialogue box is used to pick a Search Layer from the list and gives you the ability to 

search different types of information within the current module. Click the left mouse button 

on the drop down menu and then select a previously configured layer from the menu. For 

example if I want to find out Pool Information instead of Cadastre I simply select Pools from 

the drop down menu and now when I make a selection (with any of the tools below) or carry 

out a Pool Search, I will now display pool Information in the Selection Panel. If all is selected, 

then all the selection layers in the list will be searched. 

Information: 

This tool is used to retrieve information from the map layers in the Map Window. The data 

that the Information Tool can retrieve is limited to the spatial layers, whereas the Selection 

tools can be configured to retrieve data from multiple data sources. Click the left mouse 

button on the tool to activate it. Click on, or drag a circle around, the object in the map that 

you would like to retrieve information for. This tool will return information for all objects in 

any layers at the point clicked and that are set as selectable in the Layer Control. The 

information is returned in a pop-up window.  

Coordinates: 

This tool is used to retrieve the coordinate at the point specified. Click the left mouse button 

on the tool to activate it. Click on the location that you would like to retrieve the coordinate 

for. This tool will return coordinate information in the same projection as that configured for 

the Map Window. The information is returned in a pop-up window. Alternatively the 

coordinates of the current position of the mouse pointer can be viewed in the bottom left 

corner of the application window.  

Measure Distance: 

This tool is used to measure a distance in the map window. Click the left mouse button on the 

tool to activate it. Click the left mouse button in the map to designate the point you wish to 

begin your measurement. Subsequent single left clicks will allow you to measure a new 

segment and change the direction of your measurement. The intermediate distances will be 

displayed dynamically on the map as each segment is defined. Double click the mouse on the 

last point to perform the distance calculation. The total distance and the intermediate 

distances will be displayed in a result window. The unit of measurement can also be changed 

in this result window by choosing the units from the drop-down list.  
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Measure Area: 

This tool is used to measure an area in the map window. Click the left mouse button on the 

tool to activate it. Click the left mouse button on the screen to designate the point you wish 

to begin your measurement. Subsequent single left clicks will allow you to measure a new 

segment and change the direction of your measurement. The intermediate distances will be 

displayed dynamically on the map as each segment is defined. Double click the mouse on the 

last point to close the polygon and perform the area calculation. The total area, perimeter 

and the intermediate distances (including the distance from the last point back to the first to 

close the region) will be displayed in a result window. 

 

GPS: 

This tool allows you to pin point the map at your current location, providing you are viewing 

IntraMaps on a GPS enabled device. Click the left mouse button on the tool to activate it. This 

action toggles the GPS on. The map will then pan to your current location and display the 

GPS location on the map i.e. the image below. To turn the GPS off simply click the left mouse 

button on the tool to de-activate it. 
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Export 

Overview: 

The export tool bar enables the user to generate various outputs based on what is selected 

within IntraMaps. 

  

 

Mail merge: 

The Mail Merge facility in IntraMaps allows the user to download information from the 

organisations corporate database, based on objects that have been selected on the screen 

(e.g. Property Parcels) and merge this information into either of the following two formats i.e. 

Export to Microsoft Word or Export to Microsoft Excel. Please see below for more information. 

 

 

 

 

 

 

Note that MailMerge works off one or more 

selections. As a result the user can choose any of the 

standard Selection Tools or Search forms in order to 

select information. To perform a cumulative 

selection simply hold the Ctrl key on the keyboard. 

The Cursor changes to . It is now possible to add 

more selections to the existing one. To add 

cumulative selections click on the  icon in the 

Tools menu. This will allow the user to combine the 

selection along with any of the other selection tools 

and searches. 

 

Export to Word: 

To create an export to Word ensure at least one map object is selected. Left click on the 

Word icon in the Mail Merge section of the Export tool bar. Providing a Microsoft Word 

MailMerge template has been configured for the selection, the user will see one or many 

predefined templates available. Simply left click on a template name, the Export button will 

now become active. Left click on the export button. The user will then be prompted to Save 

or Open the resulting Word document. This is very useful for single or multiple database 

reporting. 

 

Export to Excel: 

To create an export to Excel ensure at least one map object is selected. Left click on the Excel 

icon in the Mail Merge section of the Export tool bar. Providing a Microsoft Excel MailMerge 

template has been configured for the selection, the user will see one or many predefined 

templates available. Simply left click on a template name, the Export button will now become 

active. Left click on the export button. The user will then be prompted to Save or Open the 

resulting Excel document. 
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Word link: 

A Word Link enables the user to open a predefined Microsoft Word Template (.doc or .docx) 

and export the content of IntraMaps (map and data from the Information Panel) into this 

Template. Word Link templates are configured for a specific Selection Layer, because the 

content of the word document will depend on the information configured in the information 

panel, which is specific to a Selection Layer. Word Links provide more flexibility in terms of 

configuring the Word template and they only apply to the currently selected record compared 

to a Mail merge template which applies to the entire selection and has some restrictions on 

the formatting due to the use of Word mail merge functionality. Word Links are ideal for 

producing reports. 

 

To use a Word link template ensure at least one map object is selected. Left click on the 

Word Link icon in the Word Link section of the Export tool bar. Providing a Microsoft Word 

Link template has been configured for the selection, the user will see one or many predefined 

templates available. Simply left click on a template name, the Export button will now become 

active. Left click on the export button. The user will then be prompted to Save or Open the 

resulting Word document.  

Print: 

To print from IntraMaps left click on the print tool, located within the Export Tool bar. The 

following dialogue will appear:  

 

  
 

The elements of the print dialogue are described below. 

 

Template - This drop down menu, is populated with all of the currently configured print 

templates that you can use. 

  

Render - There are 2 types of print outputs available: Word and PDF. Select the one on the 

type required. 

 

Title - set the title of your printed map. This information will be placed in a print template if 

it contains a section to store the print title, else it will be ignored.  

 

Scale - set the scale of your printed map. Will default to the scale of the map image in the 

selected template. Click on the drop down menu to select from a list of common scales.  

 

Format – Set the desired output format i.e. Raster (Image), Vector (Point, line & Polygon 

objects). 
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Print - click to generate your print. If your computer has word installed you will be asked if 

you would like to open the document in word for word output. Then use the word print tools 

to send to the printer. If you have a PDF reader installed  you will be asked if you would like 

to open the document in PDF reader for PDF output. Then use the word print tools to send to 

the printer. 

 

Close - closes the print dialogue. 
  



Copyright  2014 Digital Mapping Solutions 

 

Annotation 

 

The Annotation tool bar has been designed to provide the user with a set of tools for drawing 

on the currently displayed image. Features drawn into the Annotation Layer are relevant to 

the user session only and will not be seen by other users. The user now has the ability to 

save any object (or objects) that are added to the map. These annotation sets can be loaded 

back in at any time. If the user does not save the annotation sets, they will be automatically 

erased when the user exits the session.  

 

  
 

 Symbol:  

This tool will allow the user to place a symbol on the Map Window. Once the symbol tool is 

selected the following Style selection screen will appear to the right of the Annotation tool 

bar.  

 
As displayed in the above image it is now possible for the user to select a symbol from the 

library, choose the size from the Symbol slider and choose a colour from the colour picker. 

Once the user has chosen the desired size and styling, it is then possible to simply click 

within the map window to add the symbol.  

 

 Line:  

This tool will allow the user to place a line on the Map Window. Once the line tool is selected 

the following Style selection screen will appear to the right of the Annotation tool bar.  

 

  
 

As displayed in the above image it is now possible for the user to select a line style from the 

library, choose the line width from the line size slider and choose a colour from the colour 

picker. Once the user has chosen the desired size and styling, it is then possible to add the 

line to the map.  

 

To start drawing, the user can left-click in the Map Window. This will anchor the start point of 

the line. The user can then drag the mouse away from this location and left-click on a new 

location on the map. A line is drawn between the two locations. This process can be repeated 

if the user wants to create a line string. To finalise the object (i.e. Stop drawing the line) the 
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user can double left-click on the screen. The user can press the "Esc" key while drawing the 

rectangle to cancel the draw  

 

Polygon:  

This tool will allow the user to draw a Polygon or Region on the Map Window. Once the line 

tool is selected the following Style selection screen will appear to the right of the Annotation 

tool bar.  

 
As displayed in the above image it is now possible for the user to choose a fill and line colour 

from the colour pickers and adjust the line width from the line size slider. Once the user has 

chosen the desired size and styling, it is then possible to add the polygon to the map.  

 

To start drawing, the user can left-click in the Map Window. This will anchor the start point of 

the polygon. The user can then drag the mouse away from this location and left-click on a 

new location on the map. A line is drawn between the two locations. This process is then 

repeated to continue drawing the polygon object. To finalise and close the polygon the user 

can double left-click on the screen and the region will automatically be 'closed' and drawn on 

the map window. The user can press the "Esc" key while drawing the rectangle to cancel the 

draw. 

 

 Rectangle:  

This tool will allow the user to draw a Rectangle on the Map Window. Once the rectangle tool 

is selected the following Style selection screen will appear to the right of the Annotation tool 

bar.  

  
 

As displayed in the above image it is now possible for the user to choose a fill and line colour 

from the colour pickers and adjust the line width from the line size slider. Once the user has 

chosen the desired size and styling, it is then possible to add the rectangle to the map.  

 

To start drawing the user object simply left-click and hold down the mouse button in the Map 

Window. This will anchor the start point of the user rectangle. As the user drags the mouse 

away from this point the user will see the rectangle anchored to that location. Whilst dragging 

the mouse, the user can rotate the rectangle object at the same time as resizing it, by 

moving the mouse to the left and right. To complete the object release the left mouse button. 

The user can press the "Esc" key while drawing the rectangle to cancel the draw. 
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Circle:  

This tool will allow the user to draw a Circle on the Map Window. Once the rectangle tool is 

selected the following Style selection screen will appear to the right of the Annotation tool 

bar.  

  
 

As displayed in the above image it is now possible for the user to choose a fill and line colour 

from the colour pickers and adjust the line width from the line size slider. Once the user has 

chosen the desired size and styling, it is then possible to add the circle to the map.  

 

To start drawing the user object simply left-click and hold down the mouse button in the Map 

Window. This will anchor the start point of the user circle. As the user drags the mouse away 

from this point the user will see a circle anchored to that location Release the left mouse 

button to complete the circle. The user can press the "Esc" key while drawing the circle to 

cancel the draw. 

 

Note: It is also possible to draw a circle at a set radius. To do this the user simply types the 

desired radius in the radius box i.e. as per the 50m typed in the image above, and then left-

clicks within the Map Window.  

 

Text:  

This tool will allow the user to write text objects onto the map window. Once the text tool is 

selected the following Style selection screen will appear to the right of the Annotation toolbar.  

  
 

As displayed in the above image it is now possible for the user to adjust the text size, choose 

a colour and define the text to be added to the map. Once the user has chosen the desired 

text, size and styling options, it is then possible to add the text to the map by left clicking the 

desired location within the Map Window.  

 

Edit:  

This tool will allow the user to edit any symbols, lines, polygons or text that has previously 

been created in the Map Window using the above Annotation Tools (i.e. ). To 

edit a user added object(s)  simply select this tool and click on, or click and drag an area 

around, the objects the user wishes to edit from the Map Window.  
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Delete:  

This tool will allow the user to remove any symbols, lines, polygons or text that has 

previously been created in the Map Window using the above Annotation Tools (i.e.

 ). To delete a user added object(s) simply select this tool and click on, or 

click and drag an area around, the objects the user wishes to remove from the Map Window.  

 

 

Load Annotation Set:  

This tool allows the user to load pre saved annotation sets (See Save Annotation Set). To 

load an annotation set simply left-click on the Load tool and navigate to a predefined 

Annotation set. 

 

 

 Save Annotation Set:  

This tool allows a user to save predefined annotation sets. Each user can have there, own 

annotation sets saved which can be loaded at any time using the above Load Annotation Set 

tool. In order to save an annotation set you must first have some annotation drawn within 

the map window. Then simply left-click on the Save icon and the following screen will appear. 

Fill out the name and some notes, if required, and the annotation set will be saved for future 

use. The user can have multiple annotation sets.  

  

 
 

 

Clear Annotation Set: 

This tool allows you to clear all the current annotation on the screen. Simply left-click on the 

Clear tool and all annotation will be removed from the screen. If the annotation has not been 

saved it will be cleared automatically if the user changes module or if the application has 

been restarted.  
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Data Entry 

 

Data Entry gives the ability for users to create and edit data. The ability to edit data is 

controlled by your IntraMaps system administrator. Features drawn into a Data Entry Layer 

will be added to the selected layers and seen by all users.  

 

  

Symbol: 

This tool will allow you to place a symbol on the Map Window. The small arrow to the right of 

the button allows different symbols to be chosen. Click on the desired symbol, and then click 

in the map to draw the symbol in the map. The colour and size of the symbol can be set 

using the tools "Colour" and "Width" tools described at the end of this article.  

Line: 

This tool will allow you to draw a line on the Map Window. Click on the small drop down arrow 

to the right of this button and select the line style you wish to use. To start drawing your 

object simply left-click in the Map Window. This will anchor the start point of your line. As you 

drag the mouse away from this point you will see a line back to this point. Left click again at 

each 'corner' of the line you are creating. To finalise and apply the line you are drawing 

double left-click. Alternatively you can press the "Esc" key to cancel the draw.  

Polygon: 

This tool will allow you to draw a Polygon or Region on the Map Window. Click on the small 

drop down arrow to the right of this button and select the fill style you wish to use. To start 

drawing your object simply left-click in the Map Window. This will anchor the start point of 

your polygon. As you drag the mouse away from this point you will see a line anchored to 

that point. Left click again at each 'corner' of the polygon you are creating. To finalise and 

apply the polygon you are drawing double left-click and the region will automatically be 

'closed' and drawn on the map window. Alternatively you can press the "Esc" key to cancel 

the draw.  

Edit: 

The Edit tool is used to alter data in the specified data entry layer. To use, select the object 

to edit and the tool will become active. Left click on the tool to display the attribute input 

dialog. 

 

The Edit tool is only enabled when a data entry form has been configured on one of the 

selection layers located under the Selection Layer drop down box. As a result it is only 

possible to have one data entry template for each search layer within a module.  

Delete: 

This tool will allow you to remove any symbols, lines, or polygons. To delete, select the object 

to delete and the tool will become active. Left click on the tool, the object will be deleted and 

the map will refresh to reflect this.  
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Using Data Entry: 

Data Entry provides the ability for users to create edit, and delete data. The ability to edit 

data is controlled by your IntraMaps system administrator. Layers that are available for 

editing can be selected using the Selection Layer drop down box. Once the layer you wish to 

edit is specified use the Symbol, Line, and Polygon tools as described above to create an 

object. Some of these tools may be unavailable. This depends on how the data entry 

template was configured by the system administrator, and the data feature type. 

 

Once you have drawn the desired object onto the map window a dialog will appear allowing 

attribute information to be entered for the new object. Required fields are indicated with a *. 

Click the Save button to finalise and apply your data entry or the cancel button to abort the 

data entry.  

 

 
 

When using the Edit tool this dialogue will also appear.  
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Map Window 

The Map Window consists of the Main Tool bar and the Map Image.  The Main Tool bar is 

used to navigate around the map. The map image reflects the view of the area that the user 

has specified.  Below is an example of what the Map Window part of IntraMaps looks like. 

 

 Quick Zoom Tool: 

The Quick Zoom Tool provides the ability for user to quickly zoom in using the plus and zoom 

out using the minus. Other navigation tools can be found within the view menu. 

 Slider: 

The slider allows a transparent layer to appear over your map window. By clicking on the 

slider and dragging it either left or right you can increase or decrease the transparency of the 

layer. Please note that if a slider image is on, the transparency will not carry through with a 

print template or integration to Microsoft Word. 

 Quick Menu: 

The Quick Menu is a collapsible list that contains the same selection tools that are present in 

the tools menu. However, by having these also within the map window it provides quick 

access for the user. The menu List can be minimised and maximised by clicking on the  

icon. 
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 Scale bar: 

The Map Window can contain a dynamic scale bar that changes, according to the current 

zoom level. The style, position and units of the scale bar are configured by the system 

administrator. 

 Overview Map: 

The Overview Map is dynamic i.e. the location identifier  moves and resizes based on 

the current location and zoom scale within the main map window. It is also possible for the 

user to click within the Overview Map and the corresponding view of the main map window 

will change accordingly. If a user wishes to hide the Overview map, this can be achieved by 

clicking on the  icon.  

 

  



Copyright  2014 Digital Mapping Solutions 

 

Information Panel 

The information panel appears only when a Selection is made. The selections can be made 

either by the  Spatial Selection Tools or from the Search Tabs.  

The data displayed in the Information Panel is dependent on the current search layer as 

displayed in the Selection Layer. The Following is an example of the Selection Tab after a 
selection is made:  

 

If the selection layer is set to all (i.e. see the tools section), it is possible for the user to see 

what other information is available based on what is selected. This can be viewd in the 

selection pane that appears when the user clicks on the  button next to the 

current selection layer. The pane then appears i.e. as per image below, and it is now possible 

to click on any of the preconfigured selection layers to return different information in the 

Selection Panel. 
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To clear the Information panel, unselect the current 

selection by clicking on the  icon. 

 

 

 Previous/Next Buttons: 

The Next and Back buttons in the information panel become active when there is more than 1 

piece of information returned for a particular object. In the first example above there are 29 

parcels of land in the selection made by the user. The next 'Block' of data (titled Property) 

displays information relating to the current parcel data in the first 'Block' (Parcel 1 of 29). The 

Property 'block' indicates there is one property (or dwelling) on this parcel of land and is 

displaying information for property "1 of 1". In this case there are also three other sections of 

information returned. There is no record of a Pool or Animal on the property but there are 

two owners. The owner information can be displayed or hidden using the  button.  

 

This is an example only. Not all IntraMaps 
installations will be configured in this way. 

Minimise/Maximise Panels: 

It is also possible to minimise all information panels by clicking on the  icon in the panel. 

To expand minimised panel click the  icon. 

Export to CSV: 

This tool will export data for all currently selected objects to a CSV file which can be opened 

in MS Excel or saved to a file location. The data exported will be a copy of that displayed in 

the List dialog. This functionality requires appropriate Security settings. This tool only 

appears on the tool bar when a selection has been made.  

 List Button: 

If configured, the List Button will pop up a new window containing specified information about 

the map objects based upon the users selection. It may be used as an alternative to the Next 

button when there are many records selected, and it is only necessary to view information on 

a specific object. This is more efficient than scrolling through the selection (using the 

next/previous buttons) until the desired information is found. The user can now simply select 

the object from the list and view the information immediately. Data can be sorted by clicking 

on the header of a field. The first click will sort the data in ascending order. A second click, 
and the data will display in a descending order. 
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The information displayed in this window is what 

will be exported to MS Excel when using the Export 

to Excel tool. The panel can be resized by left-

clicking, and dragging an edge of the panel. This will 

also maximise the space to display text. 

 Zoom to Current Selection: 

This tool allows the user to use a single click to zoom to, and centre on, the object currently 

selected and displaying data in the Information Panel. This tool only appears when a selection 

has been made.  

 Zoom to Entire Selection: 

This tool allows the user to use a single click to zoom to, and display all currently selected 
objects in the Map Window. This tool only appears when a selection has been made.  

 

 

 Clear Selection: 

This tool Clears the current selection from the Map. 

Search Panel 

IntraMaps may have many different types of searches, depending on what is configured by 

the system administrator. The most common type of search form will select objects in the 
map window and display the associated data in the Information Panel. 

Providing the relevant search layers have been configured by your system administrator, 

each search is bound to it's own corresponding selection layer. As a result there is no need 
for the user to manually change the selection layer before performing a search.  
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Click on the relevant Search Tab to access the required search form.  

The  icon, located to the right of the search panel, allows the user to pick a search tab 

from a list. This is useful if your current setup has a large amount of search tabs. The ones 

that don't fit on the screen can be accessed by this icon.  

Each search form consists of a varying number of fields for the user to search by. For 

example, a standard address search will have a number, street and suburb field. The fields 
with a * are compulsory fields. 

When a search is performed the map will zoom to show the extent of the result of the search. 

If a street name is used in a search without a street number then all of the properties with an 

address on that street will be selected. If a street name and number are used in the search 
(and the number is valid) the map will select only the address for the number used.  

Provided your system administrator has enabled the option, searches will allow the user to 

key in a partial search. For example, a street search looking for "Boulder St" can be keyed as 

"Bou". Assuming there is only one street that starts with "Bou" and ends in "lder St", the 

result will be the same as keying in the complete search. If there is more than one street 
starting with "Bou" the search will display a list of all streets that match the partial search.  

 

 

How the search responds will be determined by the type of data and the options provided by 

your system administrator. 
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Sidebar 

Overview: 

The Sidebar is made up of the following panels: Modules, Layers, and Views. Each Panel 

contains different information for the user.  

 

  
 

Minimise/Maximise Sidebar: 

The User can hide, or 'Unpin' the entire Sidebar by clicking on the  icon located towards top 

right of the sidebar menu. This will then minimise the whole Sidebar to the left hand side of 

the screen. This provides the user with a larger map window in which to work with. To 

maximise the Sidebar simply hover the mouse pointer over the grey panel to the left of the 

screen and the menu will reappear. However, this is only temporary and as a result as soon 

as the user moves the cursor away from the sidebar it will minimise to the left hand side 

again. To ensure that the Sidebar stays visible as per the default view just click on the  

button and it will lock in place.  

Minimise/Maximise Panels:  

It is also possible to minimise various panels by clicking on the  icon next to each panel. If all 

the panels are minimised it will appear like  

 

 
 

By default only the Module and Layer panels are maximised. To maximise the other panels 

simply click on the  icon next to the desired panel. 

 

 

 

 

 

The Sidebar can be resized by moving it's right edge. 

Any text which does not completely fit into the 

Sidebar will be suffixed with an ellipsis, that is three 

dots (...). Hovering over this will display the 

complete text as a tool tip. Clicking on the text will 

permanently display the full text. Click on it again 
and the text will display with an ellipse again.  
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Modules 

An IntraMaps module has search forms and map layers specifically configured to a particular 

'theme'. The Module Panel allows the user to select from a list of modules that have been 

previously configured. Different modules can be configured to return different information 

relating to features selected from the same Search Layer, have different spatial layers 

available in the Map Window or be a completely different theme altogether. To switch 
modules simply click on the appropriate module name from the list. 

  

The arrow button on the right of the Module Select allows the module list to be 

hidden/shown. 
 

Layer Control 

The Layer Control is a tool central to configuring the information in the Map Window to suit 

the user. To access the advanced layer control click on the layer name once. It contains 

various controls that allow customization of how each individual layer of information in the 

map will be displayed. It is important to remember that the changes the user make in the 

Layer Control are made to the user current session of IntraMaps only. When the application is 
closed and then accessed again all of these changes are lost.  
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Thematic Layers: 

A thematic layer, providing it has been set up by the administrator, allows the user to show 

areas that represent a specific common thread in the data. For example a waste collection 

theme may display the days which waste collection occurs in differing colours based on the 

days of the week i.e. Monday: yellow, Tuesday: green etc...  Themes are displayed under the 

layer which it is associated too. To display the theme click the  to expand. Each theme 

class has a check box next to it which can be used to turn on/off the display of that theme. 
The legend will dynamically display each class of the visible theme i.e. 

 

Visible: 

If this check box is unchecked, the specified layer will no longer appear in the Map Window. If 

however, it is checked the layer will be displayed. The exception to this is if Zoom Layering is 
applied. For more information please see the zoom layering section below.  

  Info Enabled: 

This check box allows the user to control what map layers are returned when using the  

tool (located under the Tools menu). For example, some of the map layers in a module may 

only be there for cosmetic reasons. As a result ticking the 'Info not enabled' check box helps 
to prevent the return of irrelevant data.  

  Show Labels:  

When this box is checked a series of labels will be displayed for the specified layer, providing 

they have been configured to do so by the system administrator. The labels are generated 

from information associated with the objects in the Map Window. These objects can be seen 

using the  tool. The colour and size of the labels displayed are configurable by the 

system administrator.  

 

  Zoom/Scale Layers: 

This feature allows the user to specify the zoom or scale level at which a map layer will 

become visible/invisible. It is dependent on how the layer was set up, by the system 

administrator, as to whether the layer has been zoom or scale layered. This level is set using 

the Min and Max text boxes. The units used are predefined and will most commonly be 
metres, kilometres, feet or miles.  
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  Opacity:  

This feature allows the user to specify the transparency of the layer. 100% opacity is not 

transparent, 0% opacity is completely transparent. Unlike the Slider Map, this transparency 
will carry through to the Printing Templates or "Export to Word." 

Metadata:  

It is possible to have metadata (Information about data) associated to the user layers within 

the layer panel, providing the System Administrator has configured it. If this has been set up 

the user will see the  icon next to the layer. To access the information simply click on the 

 icon. There is also the ability to assign a hyper link next to a layer in the layer panel 

using the  icon. This tool allows the user to view an image (i.e. Advanced Legend) or web 

link in an additional dialogue box, i.e. As per the image below.  

 

 

 

Please note that like the metadata icon, the link icon will only appear if it has been configured 
by the GIS administrator.  

The Metadata is broken into two components, Calculated Metadata & User Defined Metadata. 

Calculated Metadata contains information about the File Path, Table type, Projection and the 

bounding coordinates of the file i.e. Minimum X & Y and Maximum X & Y, in other words 

bottom left and top right. This data is calculated by IntraMaps and cannot be changed 

manually within the system by the user. The other type of metadata is User Defined. This is 

controlled by the system administrator and the fields are completely configurable. The 
example below shows two fields. "Last Updated" date field and a "Custodian". 
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Quick Access Toolbar 

The Quick Access Toolbar (located in the top right of the screen) provides an additional 
selection of tools. This allows for greater user functionality within the IntraMaps application. 

 

Print:  

The Print button opens a new Print Dialogue window allowing you to select a predefined print 

template to print your map. There are additional options to specify the image type and the 

scale of the map image. For more detailed information Click Here. 

Legend: 

The Legend button launches a pop up window containing an image of the legend associated 

with the module you are viewing. If a legend is not enabled then the window will not contain 
an image. If it is configured as dynamic, only layers which are visible will be displayed.  

Help: 

The Online Help button launches the help file you are now reading. The Online Help explains 

all of the functionality of IntraMaps, including the Mapping Tool bar, Information Panel and 

Search Forms. 
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Browser Settings 

Overview 

Adding your GIS server as a trusted site allows you to connect to and send information to 

other applications such as Word and Excel. If you do not add your IntraMaps site as trusted 

you may not be able to link to other applications and your IntraMaps session may always be 

restarted if linking from another application.  

 

 

This functionality is only available in Internet 

Explorer. Other browsers do not allow the scripting 
required 

Adding IntraMaps server to the Trusted Sites  

 

• Click Tools > Internet Options...  

 

 
 

 

• Click on the Security tab and click Trusted Sites.Click Sites 
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• Uncheck the Require server verification (https:) for all sites in this zone check 

box. Type in http://<GISservername> and click Add. 

  

  
 

• Click Close to exit the Trusted Sites dialog. 
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Setting up Scripting for Trusted Sites 

 

• Make sure that Trusted Sites is still selected and click on Custom Level … 

 

  
 

• Click Enable for Intialize and script ActiveX controls not marked as safe.  

 

  
 

• Click OK to exit Security Setting dialog. 

 

• Click Yes to make the change to security settings for the Trusted Sites zone. 
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• Click OK to exit the Internet Options dialog.  

 

   
 

Enable Clipboard Access for Trusted Sites (Internet Explorer 7 and higher, only) 

 

• Make sure that Trusted Sites is still selected and click on Custom Level … 

 

   



Copyright  2014 Digital Mapping Solutions 

 

Reuse Window 

Overview 

Altering this Internet Explorer setting is desirable to ensure that any linking done to 

IntraMaps, or to another web page, will not use the current browser window in use by 

IntraMaps. If this setting is not altered then you could, for example, open a link sent to you 

via e-mail and it would close your IntraMaps session as it would reuse the available window 

to open the link. 

• Reuse Windows Click Tools > Internet Options...  

  

• Click on the Advanced tab and scroll down to Reuse windows for launching short 
cuts and untick the box i.e below. 

 


